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PE CUONG ON TIN HQC 7HOCKI I
NAM HOQC 2016 - 2017

A) ON TAP TRAC NGHIEM

I. Céu héi tric nghiém

1: Biéu tuong ctia chwong trinh bang tinh Microsoft Excel 1a biéu twong nao, trong cac biéu twong sau
day?

AW 5.13¢] c. 12 N |

2: Khdi 1a tap hop céac 6 ké nhau tao thanh hinh chir nhat. Dia chi khdi dugc thé hién nhu sau:

A.HI1...H5 B. H1:H5 C.H1-H5 D. H1->H5
3: Trong Excel ki hi€u nao sau day dung dé ki hiéu phép toan nhan trong cong thic:

A. X B. Dau cham (.) C* D./
4: Hop tén B2 cho biét thong tin:

A. Tén cua cot B. Tén cua hang

C. Dia chi 6 tinh dugc chon D. Khong c6 y nao dung

5: Trong 6 tinh xuét hién @ Vi
A. D6 rong ctia cot qua nho khong hién thi hét diy sé qua dai.
B. Do cao ctia hang qué thip khong hién thi hét ddy sé qua dai.
C. Tinh toan ra két qua sai.
D. Cong thirc nhap sai

i

6: Thanh cong thuc - dung dé:
A. Hién thi ndi dung 6 tinh dugc chon B. Nhép dir 1i€u cho 6 tinh dugc chon
C. Hién thi cong thirc trong 6 tinh dugc chon D. Ca 3y trén.

7: Dé luu trang tinh ta chon nut 1énh nao trong cac nuat 1énh sau:
A = B. d c. 4 D. =

8: Dé stra dit liéu ta:
A. Nhay dap chudt trai vao 6 can stra. B. Nhay nuat chudt trai vao 6 can stra
C. Nhay dap chudt phai vao 6 can sua D. Nhay nut chudt phai vao 6 can sua.

9: Dé tinh tong gia tri trong cac 6 E3 va F7, sau d6 nhan v&i 10% ta thyc hién bang cong thirc nao sau
day?

A. E3 + F7 * 10%. B. (E3 + F7) * 10% C.=(E3+F7)*10% D. =E3 + (F7 * 10%)
10: Cho biét két qua cua cong thic sau: =MAX(1,0,-2,-1)
Al B.-1 C.0 D. -2
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11: Bé thém cot trén trang tinh ta thyc hién nhu sau:
A. Insert / Rows B. Insert / Columns C. Table / Columns D. Table / Rows

12: Pé sao chép ndi dung 6 tinh ta sir dung nat 1énh nao sau day?

A.__ (copy). B. = (Cut). C. % (paste). D. * (new)

13: DBé di chuyén noi dung 6 tinh ta sir dung nat 1énh nao sau day?

A. L (copy). B.- (Cut). C. 2 (paste). D. 2 (new)
14: Mudn x6a mot hang hoac cdt, ta chon hang hoac cot can x6a rdi st dung 1énh nao sau day?

A. Edit/ clear B. Edit / paste C. Edit/ Cut D. Edit/ Delete
15: Cong thire =Sum(A5:A10) c6 y nghia gi? ’

A. Tinh tong cua 6 A5 va 6 A10 B. Tim gia tri 16n nhat cua 6 A5 va 6 A10

C.Tinh tong tr 6 A5 dén 6 A10 , D. Tim gia tri 16n nhat tr 6 A5 dén 6 A10
16: Céc dir li¢u nao sau day dir liu nao kiéu ki tu?

A. 20/08/1005 B. “21233” C. =(20*A1)/10 D. 21233

17: Néu chon ddng thoi nhiéu khéi 6 khac nhau khong lién tuc, ta chon khdi dau tién va nhan chon phim
nao dé lan lugt chon céc khoi 6 tiép theo?

A Alt B. Ctrl

C. Shift D. Phim nao cling dugc
18: D¢ tinh gia tri trung binh cong ctia cac 6 A1 B1 C1 cac cach tinh nao sau dau la dung?

A.=Sum( A1+B1+C1)/3 B. = AVERAGE( A1,B1,C1)

C.=(Al+ B1+ C1)/3 D. Ca A, B, C déu ding
19: Céng thirc =Max(49.8,15,2007,30) c6 két qua 1a?

A. 2109 B. 2007 C.8 D. Cong thuc sai
20: O ché @6 ngﬁm dinh, dir li€u ki tu dugc .....uveeeeeee.... trong 0 tinh

a. Can thang 18 phai b. Can gilra c. Can thang 18 trai d. Can thang hai 1&
21: O ché @6 ngém dinh, dit liéu $6 AUQC wvvevvee. trong 0 tinh

a. Can thang 18 phai b. Can gilra c. Can thang 18 trai d. Can thang hai 18
22: Thanh cong thirc khong c6 chirc nang nao dudi day:

a. Hién thi tén cua 6 tinh dugc chon b. Nhap dit li¢u cho 6 tinh dugc chon

c. Hién thi cong thire trong 6 tinh duoc chon d. Ca 3 y trén.
23: Dé chén thém cot vao trang tinh, ta thuc hién

a. Format/ cells/ Insert Columns c. Table/ Delete Columns

b. Table/ Insert cells d. Insert/ Columns
24: Cac budc dé sao chép dir liéu nhu sau. Em hiy ghép céac s6 1,2,3,4 lai cho diing:

1. Chon 6 hoic cac 6 c6 thong tin can chép ; 2. Chon 6 dich dé dua thong tin vao ;

3. Nhay nut I¢énh Copy ; 4. Nhay nut Paste.

Em chon cdu ding nhat:

a. Chon 1-2-3-4; b. Chon 1-3-2-4; c. Chon 2-3-1-4; d. Chon 1-4-3-2

25: Dé tinh tong gia tri trong cac 6 C2 va D2, sau d6 nhan cho gia tri trong 6 B2.
Cong thure nao dung trong cac cong thirc sau day:
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a. (C2+D2)*B2; b.=C2+ D2 * B2; c. =(D2+C2)*B2; d.=D2+C2*B2.
26: Cho biét két qua ctia ham =Average(4,10,16)?
A. 10 B. 30 C. 16 D. 4

27: Gia st can tinh tong cac gid tri trong cac 6 C2 va D4, sau d6 nhan véi gia tri trong 6 B2. Cong thirc
nao sau day la dang?

A. =(C2+D4)*B2; B.= C2+D4* B2;
C. (C2+D4)*B2; D.=(C2+D4)B2;
28: Dijachid B3 nam 6 :
A.CotB, cot 3 B. Dong B, cot 3
C. Dong B, Dong 3 D. C6t B, dong 3
29: Céch nhap ham nao sau day la khong dung?
A.=SUM(5,A3,B1) B.=SUM (5;A3;B1)
C.= SUM(5,A3,B1) D.=SUM(5;A3;B1)
30: Cho ham =Sum(A5:A10) dé thuc hién?
A.Tinh tong ciia 6 A5 va 6 A10 B.Tim gia tri 16n nhat cia 6 A5 va 6 A10
C.Tinh téng tir 6 AS dén 6 A10 C.Tim gia tri 16n nhat tir 6 A5 dén 6 A10
31: Dé tinh gia tri 16n nhét ta str dung ham:
A. MAX B. SUM C. MIN D. AVERAGE
32:Pé tinh tong ta st dung ham:
A. MAX B. SUM C. MIN D. AVERAGE
33: Gia sir 6 A2 co gia tri 5, 6 B8 ¢6 gia tri 27. Tinh gia tri 6 E2, biét rang E2 = MIN(A2,B8)
A. 30 B. 27 C. 34 D. 5
34:Mudn nhap cong thirc vao bang tinh, cach nhap nao 1a ding?
A.15°+4:2 B.=15°+4:2
C.=15"2 + 4/2 D. tit ca déu ding
35. Nut 1énh nao dung dé ké duong bién cho 6 tinh
& .
A B. = C. s D. LT
36. Dé ngét trang tinh ta thuc hién 1énh:
A. File > Page Setup B. View - Page Break Preview
C. View > Normal D. Tét ca déu sai

37. Cau nao sau day dang:
2 7 / H=T=) \ , , .0
A. Dé ting chit s6 thap phan ta nhan niat —° B. Dé ting chit s6 thap phan ta nhan nat

Y N A 1A A . oo Ao o A .
C. Pé giam chir s6 thap phan ta nhdn nit -~ D. Tat ca déu sai
38. bé can dir 1i€u vao gitra nhiéu 6 tinh ta st dung ntt 1€nh:

o= by 122 o/ = &=

39. bé xem trudce khi in ta st dung nuat Iénh nao duoi day:
i
2 L2 b/ 1k o/ 1 =
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40. Gia sir 6 A2 ¢6 nén mau xanh va chir mau vang. O B2 ¢6 nén mau tring va chit mau den. Néu sao
chép 6 A2 vao 6 B2 thi 6 B2 s€ ¢o:
a/ Nén mau tring va chir mau den b/ Nén mau xanh va chir mau den
¢/ Nén mau xanh va chir mau vang d/ Tat ca déu sai
41. Bé thay ddi 18 cua trang in, ta thyc hién:
a. Chon lénh File - Page Setup, chon trang Sheet
b. Chon I¢énh File = Page Setup, chon trang Magins
C. Chon Iénh File = Page Setup, chon trang Page
d. Caa,b, c déu diung
42. Tac dung cua nat 1énh Print Preview trén thanh cong cu dung dé

a. Xem trudc trang do b. Piéu chinh ché d6 ngat trang
c. Xem trang ké tiép d. Piéu chinh huéng gidy
43. PBé chon hudng gidy in cho trang tinh ta chon 1énh nao trong cac 1énh sau?
a. File > Save b. File = Close
c. File - Page Setup d. File - Print
44: Khi mé mot bang tinh méi em thuong thay gi
A. M0t trang tinh B. Hai trang tinh
C. Ba trang tinh D. Bén trang tinh
45: Cac tép bang tinh do Excel tao ra va ghi lai co phﬁn duoi mac dinh 1a ?
A. Xxls B. .doc C. .pas D. .txt
Cho bang tinh:
A B C B E F G _H |
1 |STT Ho Va Tén Ly Hoa Bia S Anh Tdng Trung hinh
2 1 Nguyén Van A 7 6 9 10 8
3

46: Dé tinh cot tong ta dung cong thic:

a. =Sum(C2+G2) b. =Sum(C2:G2)
c. =Sum (C2:G2) d. sum (C2:G2)
47: Pé tinh cot trung binh, em dung cong thuc:
a. =Average(C5:H10) b. =Average(C5:H10)/5
c. =Average(C2:G2)/5 d. =Average(C2:G2)
48: Pé tim diém 16n nhét trong cac mon hoc ta dung cong thic:
a. =Max(C2,G2) b. =Max(C2:G2)
c. = Max(C2, D2, E2, F2, G2) d. =Max (C2:G2)
49: Pé tim diém nho nhét trong cac mon hoc ta dung cong thirc:
a. =Min(C2,G2) b. Min(C2:G2)
c. = Min (C2:G2) d. = Min(C2:G2).
50. O tinh dang dugc kich hoat c6 gi khac so véi cac 6 tinh con lai:
a. Bugc t6 mau den b. C6 vién ddm xung quanh
c. C6 dudng vién nét dit xung quanh d. C6 con tré chudt nam trong d6
I1. Pién diu x vao cot Piing hoic Sai thich hop
| Cot A | Pung | Sai |
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a. Khi mo mot trang tinh méi cac cot c6 do rong bang nhau v
b. Trang tinh m&i c¢6 d6 cao cua cic hang khong bang nhau X
c. o rong ctia cot va do cao cua hang khong thé thay doi v
d. Pé dinh dang kiéu chit dam, sir dung nut 1€nh | X
e. bé dinh dang kiéu chir dam va gach chan, sir dung nut B va U X
I11. Hay ghép mdi muc & cdt A véi mot muc & cot B cho thich hop
Cot A Cot B
1. Chon Iénh Insert © Columns dé a. Di chuyén dir li€u va cong thirc
2. Chon 1énh Insert > Rows dé b. chén hang
3. Chon 1énh Edit = Delete dé c. chén cot
4. Su dyng céc nat 1énh— va BTG d. X6a hang /cot
IV. Pién tir
Hay dién cac tir (bang tinh, hang, cét, kich hoat,é, vién ddam) dé dién vao chd trong cho thich hop
Khi em nhdy chudt chon mot 6 dugc goi la........oooeevveeennennnnne. 0 tinh. Khi mot 6 tinh duoc chon thi 6
O SE COevnreeeeeeee e xung quanh. Céc tép do chuong trinh tao ra thudng goi 1a cac
.................................................. biachimftolacaptén ................va t8M.vrvrrreeseMAeenn......NAM
trén do

B) On Tap Ly Thuvét

1. Chwo'ng trinh bang tinh la gi:

Khai niém chuong trinh bang tinh: La phan mém duoc thiét ké dé gitip ghi lai va trinh bay thong tin dudi
dang bang, thuc hién cac tinh toan cling nhu xay dung cic biéu d6 biéu dién mot cach tryc quan cac sd
ligu da co trong bang.

2. Man hinh lam viéc cua Excel

+ Thanh tiéu dé + Thanh bang chon

+ Thanh cong cu + Cac nut Iénh

+ Thanh trang thai + Thanh Cuén doc, ngang
+ Thanh cong thirc + Bang chon Data

+ Trang tinh
a. Thanh cong thuc: La thanh cong cu dac trung cua chuong trinh bang tinh.

Puogc sir dung dé nhap, hién thi dit liéu hodc cong thirc trong 6 tinh.

b. Bang chon Data: Nam trén thanh bang chon (menu). Noi dé chta cac 1énh dung dé xir 1y dir lidu.

c. Trang tinh: gém céc ¢t va cac hang 1a mién lam viéc chinh cta bang tinh. Ving giao nhau giira cac
cot va hang 13 6 tinh (con goi tat 13 6) dung dé chua dir liéu.

+ Céc c0t cua trang tinh dugc danh tha tu lién tiép tur trai sang phai b?mg cac chir cai, duogc goi la tén cdt,
bat dau tr A, B, C...

+ Cac hang cua trang tinh duoc danh thir ty lién tiép tir trén xudng dudi bang cac sb, goi 1a tén hang, bat
dautr1,2,3...

+ Dia chictia 1 6 1a cap tén cdt va tén hang ma 6 nam trén do.
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3. Nhap dir liéu vao trang tinh:
a. Nhdp va swa dir liu:
* Nhap dir liu:
+ B1: Nhay chudt trai vao 6 can nhap.
+ B2: DPua dir liéu vao tur ban phim.
+ B3: Nhin phim Enter
* Svea dir ligu:
+ B1: Nhay dup chudt vao 6 can sta.
+ B2: Thuc hién cac thao tac stra dir li€u b.'?mg ban phim.
+ B3: Nhin phim Enter.
b. Di chuyén trén trang tinh:
+Sir dung chudt va cac thanh cuén doc, ngang
+ Str dung cac miii tén trén ban phim.
4. Cdc thanh phan trén trang tinh.
Céc hang, cac cot, cac 6 tinh.

- Hop tén: Bén trai thanh cong thurc, hién thi dja chi caa 6 duge chon. B4 M

- Khéi: 12 nhom 6 lién ké nhau tao thanh hinh chit nhat. Dja chi cua mot khdi 1a cdp dia chi cua 6 trén
cung bén trdi va 6 dudi cung bén phai, dugc phan cach nhau béi dau hai cham.
Vd: C3:H6

X A
- Thanh cong thirc: Cho biét noi dung cua 6 dang duoc chon.

5. Chon cac d6i twong trén trang tinh.
- Chon 1 6: Pua con tro chudt dén 6 d6 va nhay chudt
- Chon 1 hang: Nhay chudt tai ntt tén hang
- Chon 1 c6t: Nhay chudt tai nut tén cot
- Chon 1 khéi: Kéo tha chudt tir 1 6 goc dén 6 & goc ddi dién.
6. Dir liéu trén trang tinh:
a. Dit liéu sb:
-Lacacsb0,1...,9, ddu cong (+) chi s6 duong, ddu trir (-) chi s6 4m va ddu % chi ti 1é phan tram.
- O ché @6 ngém dinh, dit liéu kiéu sb dugc can théng 1é phai trong 6 tinh.
- Thong thuong, dau phay (,) dugc dung dé phan cach hang nghin, hang triéu..., ddu cham (.) dé phan
cach phan nguyén va phan thap phan.
b. Dt ligu ky tu: - La céc day cac chir cai, chir sb va cac ky higu.
- O ché @6 ngém dinh, dit liéu kiéu ki tu can théng 18 trai trong 6 tinh.

7. Mot s6 ham trong chwong trinh bang tinh.
- Trong bang tinh c6 thé sir dung cac phép tinh: +, -, *, /, », % dé tinh toan.
a. Ham tinh tong.

- Tén ham: Sum

- Cu phép: =Sum(a,b,c...)
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- Ham Sum dung d¢é tinh tong trong mot diy s6
b. Ham tinh trung binh céng
-Tén ham: AVERAGE
- Ca phap: =AVERAGE(a,b,c,...)
Ham AVERAGE dung dé tinh trung binh cong trong mot diy sd
C. Ham xac dinh gia tri lon nhat - MAX
-Tén ham: MAX
- Ca phap: =MAX(a,b,c,...)
Ham Max dung dé tim gi tri 10n nhét trong mot ddy sb
d. Ham xdc dinh gid tri nhé nhat: MIN
-Tén ham: MIN
- Cu phap: =MIN(a,b,c,...)
Ham Min dung dé tim gia tri nho nhat trong mot diy s6

8. Thao tac voi bang tinh
a. Chen thém cot hodc hang
+ Chén thém cot
B1: Nhay chudt chon mdt cot.
B2: M6 bang chon Insert va chon Columns.
Xuét hién mot cot tréng bén trai cot dugc chon.
¢ Chen thém hang
B1: Nhay chudt chon mdt hang.
B2: Mo bang chon Insert va chon Rows.
Xuat hién mot hang tréng bén trén hang duoc chon.
b. Xoa cot hodc hang
B1: Nhay chuot chon hang hoac cot can x0a.
B2: M¢ bang chon Edit va chon Delete.
C. Sao chép ngi dung 6 tinh
- Chon 6 hodc khéi 6 c6 dit liéu can sao chép.
- Nhay nut Copy trén thanh cong cu.
- Chon 6 can dua dit liéu duoc sao chép vao.
- Nhay nut Paste trén thanh cong cu.
d. Di chuyén néi dung é tinh
- Chon 6 hodc cac 6 dit lidu can chuyén.
- Nhay nut Cut trén thanh cong cu
- Chon 6 can dua dir liéu di chuyén dén.
- Nhay nut Paste trén thanh cong cu.
e. Sao chép noi dung cdc o0 co cong thurc
Khi sao chép mét 6 ¢6 ndi dung 1a cong thirc chira dia chi, cac dia chi duoc diéu chinh dé giit nguyén
quan hé twong dbi vé vi tri so véi 6 dich.
f.  Di chuyén néi dung cdc é c6 cong thire
Khi di chuyén ndi dung céac 6 c6 chira dja chi, cac dia chi trong cong thirc khong bi diéu chinh, nghia 1a
cong thirc dugc sao chép y nguyén.
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C) THUC HANH

Bai tap 1./ Cho bang sb liéu nhu sau:

A B | c | D | E | F | @
1 | BANG PIEM MON TIN HOC
z
3| sSTT HO VA TEN GIOI TINH | LY THUYET | THUC HANH | TRUNG BINH
4 1|Tran Ngoc An Nam 8 7 ?
5 2|Lé Thi Bao Anh Nir o 5
& 3|[P8 ThiKim |[cChi Nir 9 8
7 4|Bui Thi M¥  |Linh Nir 10 )
g 5(Ung ¥an Phi Nam 8 9
o 6|Vo Thi Kim Yén Nir 9 10
10 Piém cao nhat ?
11 piém thap nhat ?
a) Tinh diém trung binh ctia 16p stra dung dia chi tai 6 G4
b) Tim diém 16p nhat cua 16p stia dung dia chi tai 6 E10
¢) Tim di€ém nho nhat cia 16p stia dung dia chi tai 6 E11
Bai Tap 2:
Hay sir dung cic ham da hoc dé hoan thanh bang tinh sau:
& E | = I =] I E | F |
1 |CEu 1.4 Lap bang tinh twrong ter bang tinh sau:
=
E DANH SACH DIEM THI HOC SINH GI0OI
+ [STT Ho w3 tén Toan Aan Tin Trung hinh
5 1 [Tran Tiégn wan = G 10
& 2 [BEinh Sudc Binh G = =
7 3 |Huenh Tan Phat = =) 7
& 4 [Bd8 Le Hoa 10 7 =]
@ 5 |Bui Qudc = 9 10
10
11 Biem 1&n nhat:
1z Piem thap nhat:
13 Trung binh:
14 Tang
15
6 [24Tinh diégm TRUNG BINH cla ba man Toan, »wan, Tin.
17 |37 S dung ham firm Jiégm 1én nhat mdi man
12 4.7 S dung ham tirm diégm nhd nhat mai moan
19 |57 S0 dung ham fim Jiém trung binh mai man
zo |6/ S dung ham tim téng diem mai man
z1 |[F./ Sap 8 tinh wa can gidra dang tiégu dé&, tang cd chir, kidu chir in dam.
zz |8/ Can gidra dir liegu Kiéu so
zz (9.7 Lam tron diém trung binh dén 1 chiy s phan thap phan.
z4 (107 T mau nen. mau chirv. ké duwéng bién.
Bai tap 3:

Lap bang tinh nhu sau:
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A =] [ ] E F €]
1 |STT|TEN SACH [BON CIA  [S46 LIT'ONG |THANH TIEN |HUE PHONG |TIEN PHAIL TRA
2 1 |[VANMG 6500 70
3 2 | TOAMNG 7000 on
4 3 |ANHG 5,000 85
= 4 |WANT 5500 65
= s |TOANT 7 S00 g0
7 6 |ANHT 6,500 75
=] T |WAN® 8,000 48
= g8 |TOAN T S00 38
10 o (ST o &.,000 40
1 Tdng céng
12 Tl &
13 | TAIET
14 Trung binh
15 |
16 CEu 1 Bign 3TT
E T'#u 2 Tinh Thanh Tign = S8 hremg * Pon gia
18 ZEu 3 0 Tinh Hué Phang = 10%0 * Thanh Tién
E TEu <} Tinh t:ije‘n phai tra = Thanh Tién - Hué ¢
20 CZau S Tinh tdng cdéng, IWlas, IWling, Trung binh
Bai tap 4:
Lap bang tinh nhw sau:
A, B C D E F G
1 | MA HANG | TEN HANG | SO LUONG | PON GIA |TRI GIA| THUE |TiEN TRA
2 Bl bt gidt 12 7.000
3 Kl kem 20 14.000
4 X1 xXa béng 25 5.500
5 X2 xXa béng 15 5.000
] K2 kem a8 15.000
7 B2 bt gidt 5 7.500
f Téng cong
9 MAX
10 NI
11 Trung binh
12
13 |Lap cdng thurc, ham, tinh:
14|Céu 1 : Tri gia = s6 lrgng * don gia
15 |C4éu 2 : Thué = Tri gia * 10%0
16| C4én 3 : Tién tra = Tri gia + thué
17 |Céu 4 : Tinh téng céng cac cét
18 |C4u S : Tinh téng céng , max , min
19 |Can 6: Tang giam dé rong hang cot, ké dwong hién

[
mm}

Ciau 7: Pinh dang, trang tri trang tinh
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